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Preface
SBAU154–April 2009

Read This First

About This Manual
This document provides the information needed to set up and operate the DEM-DAI1789 EVM evaluation
module, a test platform for the 24-bit, 192-kHz, differential output, two-channel PCM1789 audio
digital-to-analog converter (DAC). For a more detailed description of the PCM1789, refer to the product
data sheet available from the Texas Instruments web site at http://www.ti.com. Support documents are
listed in the section of this guide entitled Related Documentation from Texas Instruments.

How to Use This Manual
Throughout this document, the abbreviation EVM and the term evaluation module are synonymous with
the DEM-DAI1789 EVM. The abbreviation DUT refers to the PCM1789 device. Unless specifically noted,
the information presented in this manual applies to the PCM1789.

Chapter 1 describes the hardware setup guide for the EVM, including the necessary information required
to configure the EVM switches and jumpers for product evaluation.

Chapter 2 explains how to use the software provided with the DEM-DAI1789 EVM for controlling the
PCM1789.

Chapter 3 includes the EVM electrical schematics, printed circuit board (PCB) layouts, and the bills of
material for both the DEM-PCM1789 and the DEM-DAI/DAC_USB evaluation platform motherboard.

Information About Cautions and Warnings
This document contains caution statements.

CAUTION
This is an example of a caution statement. A caution statement describes a
situation that could potentially damage your software or equipment.

The information in a caution or a warning is provided for your protection. Please read each caution and
warning carefully.

Microsoft, Windows are registered trademarks of Microsoft Corporation.
SPI is a trademark of Motorola Inc.
I2C, I2S are trademarks of NXP Semiconductors.
TOSlink is a trademark of Toshiba Corporation.
All other trademarks are the property of their respective owners.
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Related Documentation From Texas Instruments www.ti.com

Related Documentation From Texas Instruments
The following document provides information regarding Texas Instruments integrated circuits used in the
assembly of the DEM-DAI1789 EVM. These documents are available from the TI web site. The last
character of the literature number corresponds to the document revision that is current at the time of the
writing of this document. Newer revisions may be available from the TI web site at http://www.ti.com/ or
call the Texas Instruments Literature Response Center at (800) 477-8924 or the Product Information
Center at (972) 644-5580. When ordering, identify the document(s) by both title and literature number.

Data Sheet Literature Number
PCM1789 Product data sheet SBAS451A
DIR9001 Product data sheet SLES198

TUSB3410 Product data sheet SLLS519G
OPA2134 Product data sheet SBOS058

MSP430F169 Product data sheet SLAS368
SN74LVC2G14 Product data sheet SCES200L

TPS76933 Product data sheet SLVS203E
REG1117 Product data sheet SBVS001D

SN74LVC2GU04 Product data sheet SCES197M
SN74LVC1T45 Product data sheet SCES515H

SN74LV541 Product data sheet SCES573A

If You Need Assistance
If you have questions regarding either the use of this evaluation module or the information contained in the
accompanying documentation, please contact the Texas Instruments Product Information Center at (972)
644–5580 or visit the TI web site at www.ti.com.

FCC Warning
This equipment is intended for use in a laboratory test environment only. It generates, uses, and can
radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable
protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense is required to
take whatever measures may be required to correct this interference.

Trademarks
All trademarks are the property of their respective owners.
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Chapter 1
SBAU154–April 2009

Description and Hardware

The DEM-DAI1789 is an evaluation board for the PCM1789, a 24-bit, 192-kHz, differential output,
two-channel audio DAC with a digital audio receiver, two-channel second-order post filter, mode control
interface to PC, and various switches and jumpers for configuration controls.

The DEM-DAI1789 operates from 5-V and ±15-V analog power supplies with an S/PDIF input signal.

Topic .................................................................................................. Page

1.1 Block Diagram .......................................................................... 10
1.2 Basic Connections and Operation............................................... 11
1.3 EVM Configuration Controls....................................................... 11
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1.1 Block Diagram
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1.1.1 Electrostatic Discharge Warning

Block Diagram www.ti.com

Figure 1-1 shows a block diagram of the DEM-DAI1789, which consists of the DEM-DAI/DAC_USB and
the DEM-PCM1789 (the DUT daughterboard).

Figure 1-1. DEM-DAI1789 Block Diagram

Many of the components on the DEM-DAI1789 EVM are susceptible to damage by electrostatic discharge
(ESD). Customers are advised to observe proper ESD handling precautions when unpacking and handling
the EVM, including the use of a grounded wrist strap at an approved ESD workstation.

CAUTION
Failure to observe ESD handling procedures may result in damage to EVM
components.
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1.2 Basic Connections and Operation

1.3 EVM Configuration Controls

1.3.1 HDR001

1.3.2 HDR101

1.3.3 JP101

1.3.4 JP102

www.ti.com Basic Connections and Operation

Follow these procedures to configure the DEM-DAI1789 for use.
• Set/confirm HDR001/101, JP101/2, and SW102 to set the proper EVM power configuration and mode

control interface for the PCM1789.
• Set/confirm HDR202/203 and SW203 to provide the proper system clock and other signals from the

digital audio receiver to the PCM1789.
• Set/confirm jumper JP401-408 to select the interface type (differential or single-ended, ac- or

dc-coupling) between the DAC outputs and the second-order low-pass filter (LPF) buffer.
• Set/confirm HDR302 to select the PCM1789 mode control type. No change from the default setting is

required for general evaluation purposes.
• Connect the +5-V and ±15-V power supplies to VCC, AVCC, –AVCC, and GND on connectors CN001 to

CN005.
• Connect the S/PDIF signal into CN201 (COAX) or U201 (OPT), and connect the PC USB port to

CN101 for mode control if required.
• Set/confirm the input data clock and format using SW201, SW102 (hardware control) or the EVM

control software (software SPI™ or I2C™ control) and power on to EVM.

This section presents the standard parameters for the EVM. For normal operation, configure the EVM as
discussed here.

This header selects the power-supply source for the control and DIR blocks of the EVM.
• 1–2: Use the power supply provided on CN004/5 (default)
• 2–3: Use a separate power supply provided on 2-3 of HDR001

No change from the default setting is required for general evaluation purposes.

HDR101 selects the power-supply configuration of the USB Interface block.
• SELF: Use the EVM power supply for the USB Interface block (default)
• BUS: Use the PC power supply provided via a connected USB cable

No change from the default setting is required for general evaluation purposes.

This jumper enables the pull-up resistors for the I2C control mode.
• ON: Enables two 1-kΩ pull-up resistors (one each for SCL and SDA) (default)
• OFF: Disables pull-up resistors (for hardware control mode)

No change from the default setting is required except when using hardware control mode.

JP102 enables a software control signal to be sent via USB to the DUT (PCM1789) according to the mode
control selection of HDR302.
• ON: Enables signal to be sent to DUT in either SPI or I2C control mode (default)

– SPI mode: 1-2,5-6,7-8: ON, 3-4: OFF for ADR5 by SW102.
– I2C mode: 1-2,5-6: ON, 3-4,7-8: OFF for ADR1/0 by SW102.

• OFF: Disables the signal to be sent to DUT in hardware control mode

No change from the default setting is required except when using hardware control mode.
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1.3.5 CN102

1.3.6 SW101

1.3.7 SW102

1.3.8 HDR202 (with HDR203, CN204 and CN205)

1.3.9 SW201

EVM Configuration Controls www.ti.com

CN102 enables the test and write interface for U104; it is not used in any customer application. Always
keep this connector open.

This switch resets the USB Interface (U102) and Mode Control Interface (U104) operation.

SW102 enables the user to set (or reset) the address for SPI/I2C mode, if required, and the control signal
for hardware control mode. These functions are defined for the PCM1789; the default setting is OFF.
• 1–8: ADR5(SPI)/ADR1(I2C)/OFF(H/W) (PCM1789, pin 24)
• 2–7: OFF(SPI)/OFF(I2C)/DEMP(H/W) (PCM1789, pin 21)
• 3–6: OFF(SPI)/OFF(I2C)/FMT(H/W) (PCM1789, pin 22)
• 4–5: OFF(SPI)/ADR0(I2C)/OFF(H/W) (PCM1789, pin 23)

No change from the default setting is required except when using hardware control mode.

The DEM-DAI1789 supports a flexible PCM audio interface through a DAI bridge, so that the PCM1789
can interface with external devices or equipment in place of the DIR9001 digital receiver through an
internal buffer. Interfacing with external components or devices can be done by changing the HDR202
connections of SCKI, BCK, LRCK, DATA, and GND from the left side setting to the right side setting, and
SCKI configuration for interfacing with external can be also changed by using HDR203, CN204, and
CN205. There is no change required from the default setting for general evaluation.

SW201 selects the system clock rate and format for U203, the DIR9001 digital receiver. Table 1-1 and
Table 1-2 list the system clock rate selection and data format selection options, respectively, for the
DIR9001 (U203).

Table 1-1. SW201: System Clock Rate Selection for DIR9001
PSCK1 PSCK0 System Clock Selection
On (H) On (H) 512 fS (Default)
On (H) Off (L) 384 fS
Off (L) On (H) 256 fS
Off (L) Off (L) 128 fS

Table 1-2. SW201: Data Format Selection for DIR9001
FMT1 FMT0 Data Format Selection
On (H) On (H) 16-bit to 24-bit, MSB-first, I2S™ format

(default)
On (H) Off (L) 16-bit to 24-bit, MSB-first, left-justified

format
Off (L) On (H) 24-bit, MSB-first, right-justified format
Off (L) Off (L) 16-bit, MSB-first, right-justified format
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1.3.10 SW202

1.3.11 SW203

1.3.12 SW204

1.3.13 HDR301

1.3.14 HDR302

1.3.15 SW301

1.3.16 SW302

1.3.17 JP401/405 (6–4)

www.ti.com EVM Configuration Controls

This switch selects the S/PDIF input signal for U203.
• OPT: Selects the optical input (default)
• COAX: Selects the coaxial input

This switch selects the operating mode for U203.
• X'tal: Always output the XTI clock source
• PLL: Always output the recovered clock by PLL
• AUTO: Automatic clock selection by ERROR status (default)

SW204 resets the DIR (DIR9001) operation.

This header selects the input clock and data for DSD signal.
• 1–2: Input terminal for DSD-L signal
• 3–4: Input terminal for DSD-R signal
• 5–6: Input terminal for DSD-BCK signal
• 7–8: Input terminal for DSD-SCK signal

No change from the default setting is required for general evaluation purposes.

This header selects the mode control of the PCM1789.
• 1–2 (I2C): Software (I2C) control mode
• 3–4 (P/D): Hardware control mode
• 5–6 (P/U): Software (SPI) control mode with ADR6 = 0 (default)
• 7–8 (SPI): Software (SPI) control mode with ADR6 = 1

Either one of these four options must be selected before powering on the EVM; no change from the
default setting is required for general evaluation purposes.

SW301 resets the DUT (PCM1789) operation.

This switch controls the AMUTE (Analog Mute) function.

These jumpers control the signal flow from the DUT to the post low-pass filter/buffer.
• Open: Differential interface (default)
• Short: Single-ended interface

No change from the default setting is required for general evaluation purposes.
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1.3.18 JP402/406 (1–2, 3–4)

1.3.19 JP403/404/407/408

EVM Configuration Controls www.ti.com

These jumpers control the signal flow from the DUT to the post low-pass filter/buffer.
• Open: AC coupling (default)
• Short: DC coupling

No change from the default setting is required for general evaluation purposes.

These jumpers select the interface type for the DUT to the post low-pass filter/buffer.
• Open: Differential interface (default)
• Short: Single-ended interface

No change from the default setting is required for general evaluation purposes.
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Chapter 2
SBAU154–April 2009

Application Software

This chapter describes the functions and use of the DEM-DAI1789 EVM application software. The
software provided with the DEM–DAI1789 allows programming of the PCM1789 internal registers. The
software operates on computers that are equipped with Microsoft® Windows® 2000 and XP operating
systems, and requires connection of the USB port to CN101 of the DEM–DAI1789 using a standard USB
cable.

Topic .................................................................................................. Page

2.1 Description and Installation........................................................ 16
2.2 Software Start-up Procedure ...................................................... 16
2.3 Using the Application Software................................................... 17
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2.1 Description and Installation

2.2 Software Start-up Procedure

Description and Installation www.ti.com

Download the following software tools and documentation from the PCM1789 product folder on the TI web
site.
• Virtual COM port driver software (that is, the USB driver software) for the TUSB3410.
• Application software for the DEM-DAI1789
1. Installation Procedure for Virtual COM Port Driver Software

Refer to the documentation in the downloaded file (Virtual COM Port Driver Installation Instructions.pdf;
also available at http://focus.ti.com/docs/toolsw/folders/print/tusbwinvcp.html)

2. Installation Procedure for Application Software
There is no installer software required. Copy the downloaded application software folder to the desired
local folder. To uninstall the software, delete the local folder.

Note: This procedure is very important in order for the DEM-DAI1789 to be properly detected by
the PC.

Step 1. Set HDR302 on the DEM-DAI1789 for SPI mode with ADR6 = 0. (If you prefer to use SPI
mode with ADR6 = 1 or I2C mode, set HDR302 to the required position.)

Step 2. Turn on the power supply for the DEM-DAI1789.
Step 3. Connect the USB connector on DEM-DAI1789 to the PC.
Step 4. Launch the application software ( that is, EVM1789.exe). The default control mode for the

application software is SPI with address 00; if you prefer to use I2C mode or another address,
change the control mode setting to I2C or the address (respectively), and then push the
Reconnect button on the application software interface. After that, the preferred setting is
stored on the PC for both the DEM-DAI1789 and the software.

Error Message at Software Start-up
If the DEM-DAI1789 is not correctly detected by the application software, the error message shown in
Figure 2-1 appears on the PC. After pushing OK, the application software will launch with an indication
of No EVM in red, and controlling the DEM-DAI1789 is impossible. In this case, check the USB
connection between the DEM-DAI1789 and the PC, and the power-supply connection and voltage;
unplug and reconnect these cables as needed, then try launching the software again by pushing the
Reconnect button.

Figure 2-1. Error Message at Software Start-up
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2.3 Using the Application Software
www.ti.com Using the Application Software

This section discusses the various controls available in the application software using screenshots and
describing the possible control functions for each tab.

For evaluation of PCM1789 audio performance with EVM default conditions settings, no application
software operation and no switch, jumper, or header setting changing on the EVM are required. This
application software is used to control the register contents of the PCM1789 to various values necessary
for a given application.

The PCM1789 operating mode, including the audio interface format and sampling mode, can be set
through the serial control port by this PCM1789 control application software in either I2C or SPI control
mode.

The application software is not required for PCM1789 hardware control mode. Switch SW102 on the EVM
is used for limited functions in hardware control mode.
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2.3.1 Audio Interface and Sampling Mode Control (SPI Mode)
Using the Application Software www.ti.com

Figure 2-2 shows the audio interface and sampling mode control tab for SPI mode.

Figure 2-2. Audio Interface and Sampling Mode Control Tab—SPI Mode Recognized

This screen has the following features:
• This tab is the initial window that appears, and indicates that the USB connection with the PC and the

EVM is properly recognized; it also shows that SPI serial control is the interface mode.
• PCM1789 audio interface mode and oversampling mode can be set in this window.

Additionally, four important controls are visible in Figure 2-2.

Reconnect
This button performs a reconnect operation between the PC and the EVM. When the interface mode
(either I2C or SPI) or the address for I2C and SPI changes, pushing this button is required. For system
recovery after releasing the USB cable or turning off the EVM power supply, pushing this button is also
required.

Exit
This button closes and exits the application software.

MRST (Mode Register Reset)
The MRST button resets all PCM1789 register settings and the application software.

SRST (System Reset)
The SRST button resynchronizes the PCM1789. The register setting is not cleared.
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2.3.2 Audio Interface and Sampling Mode Control (I2C Mode)
www.ti.com Using the Application Software

Figure 2-3 illustrates the audio interface and sampling mode control tab for I2C mode.

Figure 2-3. Audio Interface and Sampling Mode Control Tab—I2C Mode Recognized

As with SPI mode (see Section 2.3.1), this initial display screen confirms proper a USB connection with
the PC and the EVM, as well as indicates that I2C serial control mode is properly recognized.

In both SPI and I2C modes, there is an additional control that becomes active:

Address Setting
This field sets the SPI port address and I2C slave address for the software. This address must concur
with the address registered on the EVM. In other words, the SPI and I2C address of the EVM and the
software must be the same.
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2.3.3 USB Connection and EVM Not Recognized
Using the Application Software www.ti.com

Figure 2-4 displays the audio interface and sampling mode control tab as it appears when the USB
connection with the PC and the EVM and/or serial control mode is not properly recognized. Note the red
No EVM button.

Figure 2-4. Audio Interface and Sampling Mode Control Tab—USB Connection and EVM Not Recognized

Troubleshooting
If there is no change after pushing Reconnect button, the following items should be checked:

q Are the power supplies correctly distributed for the EVM?
q Is the EVM properly connected to the PC?
q Is the USB port on the PC activated?
q Is the Virtual COM port driver software (that is, the USB driver software) correctly installed on the PC?
q Is the selection of SPI/I2C control mode coincident between the application software and the EVM

setting for the PCM1789?
q Is the device address the same for the application software and the EVM setting on the PCM1789?

If you have thoroughly reviewed these procedures and there continues to be no change with the No
EVM indication, contact the Texas Instruments product support center nearest you for assistance.
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2.3.4 Operation Mode Control
www.ti.com Using the Application Software

The operation mode control tab is shown in Figure 2-5.

Figure 2-5. Operation Mode Control Tab

This tab has the following features:
• Power-Save Mode
• De-emphasis
• Digital filter roll-off
• Polarity (phase) between input and output

As illustrated in Figure 2-5, these features can be controlled for both left and right channels.

SBAU154–April 2009 Application Software 21
Submit Documentation Feedback

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SBAU154


2.3.5 Digital Attenuation and Soft Mute Control
Using the Application Software www.ti.com

Figure 2-6 shows the digital attenuation and soft mute control tab.

Figure 2-6. Digital Attenuation and Soft Mute Control Tab

Digital attenuation can be controlled for each channel by either changing the slider location or directly
entering a target number in 0.5- or 1-dB increments.
• Soft mute on or off using digital attenuation can be also controlled for each channel; operation of digital

attenuation control is ignored while the mute is on.
• Choose between Fine or Wide digital attenuation mode (fine control extends to 63 dB with 0.5-dB

steps; wide control covers a 100-dB range with 1.0-dB steps),
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2.3.6 Zero Flag Control and Monitor
www.ti.com Using the Application Software

Figure 2-7 shows the zero flag control and monitor tab.

Figure 2-7. Zero Flag Control and Monitor Tab

Both the function and the signal polarity of the zero flag pins (PCM1789 pins 19 and 18) can be controlled,
as well as the selection of the Zero Flag function or AMUTEO Function for the ZERO2 pin. The status of
zero input detection is updated by channel when a Read command is performed; a zero flag indication is
cleared by pushing the Clear button.
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2.3.7 Analog Mute Function Control
Using the Application Software www.ti.com

Figure 2-8 illustrates the analog mute function control tab.

Figure 2-8. Analog Mute Function Control Tab

This window enables the user to select a source event for the analog mute control function of the
PCM1789. Four source events can be selected independent of each other:
• SCKI lost
• Asynchronous clocks
• ZERO1 or ZERO2 detection
• DAC disable command
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2.3.8 Register Setting History, Register Direct Access
www.ti.com Using the Application Software

The Register Setting History and Register Direct Access area of the software interface is shown in
Figure 2-9.

Figure 2-9. Register Setting History, Register Direct Access Area

Register Setting History
The register setting history is shown as Register Address, Register Data in hexadecimal. This history
can be downloaded as a comma-separated value (.csv) file by pressing the Save button. An upload
function is also available from the File menu. The Clear button clears this history.

Register Direct Access
Both read and write functions (read and write any data to or from any address) are available.

Open Script from File Menu
This menu uploads a previously saved register setting snapshot from a stored .csv file.

Save Register Snapshot from File Menu
This menu downloads a register setting snapshot in .csv file format. The saved register setting
snapshot can then be uploaded by the File/Open Script command.
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2.3.9 Register Contents View
Using the Application Software www.ti.com

Figure 2-10 illustrates a view of the register contents. This option shows all registers of the PCM1789 in a
register map format.

Figure 2-10. Register Contents View

The Register View window has three options (available in the application software):

Open Register View Window
Select Tools → Register Map. This window indicates latest entire register settings of PCM1789.

Register View Window Color Indicators
Green shaded cells (as shown in Figure 2-10) indicate a register value of '1'. White shaded cells
indicate a register value of '0'.

Register View Window Operation
After updating a register setting for the PCM1789 through the application software, the update is
reflected in this register view.
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Chapter 3
SBAU154–April 2009

Typical Performance and Example Data

This chapter presents typical PCM1789 performance and example measurement data when measured
with the DEM-PCM1789.

Topic .................................................................................................. Page

3.1 Typical Performance Data .......................................................... 28
3.2 Example Measurement Data ....................................................... 29
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3.1 Typical Performance Data

3.1.1 Typical Performance vs Sampling Rate and System Clock
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This section illustrates baseline PCM1789 performance on the DEM-PCM1789 with the default
configuration. These data include typical performance versus sampling rate and system clock, and FFT
results for full-scale, –60 dB, –120 dB, and bipolar zero at 48 kHz/512 fS. As a result of a performance
limitation of the differential to single-ended converter followed by the PCM1789 output, the reading
performance is shown with 1-dB to 1.5-dB degradation in dynamic range, signal-to-noise ration (SNR),
and channel separation.

Figure 3-1 shows typical PCM1789 performance versus the sampling rate and system clock.

Figure 3-1. Typical Performance vs fS and fSCK
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3.2 Example Measurement Data

3.2.1 FFT: 0-dB Output
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3.2.2 FFT: –60-dB Output
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www.ti.com Example Measurement Data

Figure 3-2 through Figure 3-5 show the dynamic performance of the PCM1789 in a variety of FFT graphs.

Figure 3-2. FFT (0 dB)

Figure 3-3. FFT (–60 dB)
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3.2.3 FFT: –120-dB Output
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3.2.4 FFT: Bipolar Zero Output
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Figure 3-4. FFT (–120 dB)

Figure 3-5. FFT of BPZ Output
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Chapter 4
SBAU154–April 2009

Schematics and Printed Circuit Board Layouts

This chapter presents the schematics, printed circuit board (PCB) layouts, and bills of material (BOMs) of
the DEM-DAI/DAC_USB and the DEM-PCM1789.
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4.1 DEM-DAI/DAC_USB Schematics ................................................. 32
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4.4 Bills of Material (BOMs) ............................................................. 44
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4.1 DEM-DAI/DAC_USB Schematics

4.1.1 DEM-DAI/DAC_USB Power Supply
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The power-supply section is shown in Figure 4-1.

Figure 4-1. Power-Supply Section

Schematics and Printed Circuit Board Layouts32 SBAU154–April 2009
Submit Documentation Feedback

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SBAU154


4.1.2 DEM-DAI/DAC_USB USB and MCU
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The USB and MCU section is illustrated in Figure 4-2.

Figure 4-2. USB and MCU Sections
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4.1.3 DEM-DAI/DAC_USB DIR
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Figure 4-3 shows the DIR section.

Figure 4-3. DIR Section
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4.1.4 DEM-DAI/DAC_USB Interface to DUT Board
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Figure 4-4 illustrates the interface to DUT board section.

Figure 4-4. Interface to DUT Board Section
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4.1.5 DEM-DAI/DAC_USB LPF and Buffer
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The LPF and buffer section is shown in Figure 4-5.

Figure 4-5. LPF and Buffer Sections
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4.2 DEM-PCM1789 Schematic (DUT Daughtercard)
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Figure 4-6 shows the DEM-PCM1789 schematic.

Figure 4-6. DEM-PCM1789
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4.3 Printed Circuit Board Layouts

4.3.1 DEM-DAI/DAC_USB Silkscreen (Top)

Printed Circuit Board Layouts www.ti.com

Note: Board layouts are not to scale. These figures are intended to show how the board is laid out;
they are not intended to be used for manufacturing DEM-DAI1789 PCBs.

Figure 4-7 shows the silkscreen plane, top layer image.

Figure 4-7. Silkscreen
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4.3.2 DEM-DAI/DAC_USB Top Layer
www.ti.com Printed Circuit Board Layouts

Figure 4-8 shows the top layer image of the board.

Figure 4-8. Top Layer
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4.3.3 DEM-DAI/DAC_USB Bottom Layer
Printed Circuit Board Layouts www.ti.com

Figure 4-9 shows the bottom layer image of the board.

Figure 4-9. Bottom Layer
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4.3.4 DEM-PCM1789 (DUT Daughterboard) Silkscreen
www.ti.com Printed Circuit Board Layouts

Figure 4-10 shows the silkscreen plane, top layer image for the DUT daughterboard.

Figure 4-10. Silkscreen
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4.3.5 DEM-PCM1789 (DUT Daughterboard) Top View
Printed Circuit Board Layouts www.ti.com

Figure 4-11 shows the top layer image for the DUT daughterboard.

Figure 4-11. Top Layer
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4.3.6 DEM-PCM1789 (DUT Daughterboard) Bottom View
www.ti.com Printed Circuit Board Layouts

Figure 4-12 shows the bottom layer image for the DUT daughterboard.

Figure 4-12. Bottom Layer
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4.4 Bills of Material (BOMs)
Bills of Material (BOMs) www.ti.com

Table 4-1 lists the BOM information for the DEM-DAI/DAC_USB board. Table 4-2 includes the BOM
information for the DEM-PCM1789 board.

Table 4-1. Bill of Materials: DEM-DAI/DAC_USB
Qty Reference Designators Part Name, Type Specification Manufacturer Part No Manufacturer

2 C207, C208 Chip Ceramic 18 pF, J Murata
Capacitor

4 C107, C108, C114, C115 Chip Ceramic 22 pF, J Murata
Capacitor

20 C004, C006, C101, C105, C106, Chip Ceramic 0.1 µF GRM188B11E104KA01 Murata
C109, C111, C112, C201, C203, Capacitor
C204, C206, C209, C214-C218,

C302, C303

1 C103 Chip Ceramic 1 µF GRM188B11A105(K) Murata
Capacitor

3 C102, C104, C113 Chip Ceramic 10 µF GRM21BB31A106KA Murata
Capacitor

4 C405, C406, C413, C414 Polypropylene 470 pF APSF0100J471 NISSEI
Capacitor

5 C211, C403, C404, C411, C412 Polypropylene 4700 pF APSF0100J472 NISSEI
Capacitor

1 C212 Polypropylene 0.068 µF APSF0100J683 NISSEI
Capacitor

3 C110, C213, C301 Chip Tantalum 10 µF/16 V ESVA1C106M NEC TOKIN
Capacitor

5 C005, C007, C202, C205, C210 OS Capacitor 10 µF/16 V 16SS10M Sanyo

6 C401, C402, C407-C410 Electrolytic Capacitor 10 µF/16 V R0A-16V100M ELNA

3 C001-C003 Electrolytic Capacitor 220 µF/25 V R0A-25V221M ELNA

11 R212-R215, R303-R309 Chip Resistor 33 Ω, D RR0816 Susumu

2 R408, R416 Chip Resistor 47 Ω, D RP0816 Susumu

1 R201 Chip Resistor 75 Ω, D RR0816 Susumu

1 R205 Chip Resistor 330 Ω, D RR0816 Susumu

8 R104, R204, R211, R302, R406, Chip Resistor 470 Ω, D RP0816 Susumu
R407, R414, R415

2 R208, R209 Chip Resistor 680 Ω, D RR0816 Susumu

2 R101, R311 Chip Resistor 1.5 kΩ, D RP0816 Susumu

3 R102, R203, R207 Chip Resistor 2.2 kΩ, D RP0816 Susumu

4 R404, R405, R412, R413 Chip Resistor 7.5 kΩ, D RP0816 Susumu

7 R105, R401-R403, R409-R411 Chip Resistor 10 kΩ, D RP0816 Susumu

5 R103, R202, R210, R301, R310 Chip Resistor 47 kΩ, D RP0816 Susumu

1 R106 Chip Resistor 100 kΩ, D RP0816 Susumu

1 RA101 Resistor Networks 33 Ω (x2) CN1J2 KOA

1 RA301 Resistor Networks 470 Ω (x2) CN1J2 KOA

1 RA105 Resistor Networks 1 kΩ (x2) CN1J2 KOA

1 RA102 Resistor Networks 10 kΩ (x2) CN1J2 KOA

1 RA302 Resistor Networks 220 kΩ (x2) CN1J2 KOA

2 RA103, RA104 Resistor Networks 10 kΩ (x4) CN1J4 KOA

1 RA106 Resistor Networks 47 kΩ (x4) CN1J4 KOA

1 L101 Chip Ferrite Bead MPZ2012S331A TDK

3 D102, D204, D301 Chip Diode HSU119-E Renesas

3 D001-D003 Diode CMS05 Toshiba

3 D201, D302, D303 LED Green TLPGU1002A Toshiba

1 D304 LED Orange TLOU1002A Toshiba

2 D101, D202 LED Red TLSU1002A Toshiba

1 D203 LED Yellow TLYU1002A Toshiba

1 Q101 Digital Transistor DTC143E ROHM
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www.ti.com Bills of Material (BOMs)

Table 4-1. Bill of Materials: DEM-DAI/DAC_USB (continued)
Qty Reference Designators Part Name, Type Specification Manufacturer Part No Manufacturer

1 U401 Op Amp OPA2134PA TI

1 U206 Logic IC Package: DCK SN74LVC1T45 TI

3 U103, U204, U301 Logic IC Package: DCK SN74LVC2G14 TI

1 U202 Logic IC Package: DCK SN74LVC2GU04 TI

1 U205 Logic IC SN74LV541 TI

1 U203 IC DIR DIR9001 TI

1 U104 IC MCU MSP430F169IPM TI

1 U102 IC USB TUSB3410VF TI

1 U101 IC 100 mA, 3.3 V TPS76933 TI

2 U001, U002 Regulator IC 800 mA, 3.3 V REG1117-3.3 TI

1 U201 TOSlink™ Receiver TORX141 Toshiba

1 X101 Crystal Resonator 12.000 MHz CX5032GB KSS

1 X201 Crystal Resonator 24.576 MHz CX5032GB KSS

1 X102 Crystal Resonator 32.768 kHz FC-135, 12.5pF EPSON

3 HDR001, HDR101, HDR203 TH-type Male 3-pin FFC-3AMEP1 HTK
Connector

2 HDR301, HDR302 TH-type Male 8-pin FFC-8BMEP1 HTK
Connector

1 HDR202 TH-type Male 21-pin FFC-21NSM1 HTK
Connector

5 JP202, JP403, JP404, JP407, TH-type Male 2-pin FFC-2BMEP1 HTK
JP408 Connector

3 JP101, JP402, JP406 TH-type Male 4-pin FFC-4BMEP1 HTK
Connector

1 JP201 TH-type Male 6-pin FFC-6BMEP1 HTK
Connector

1 JP102 TH-type Male 8-pin FFC-8BMEP1 HTK
Connector

1 CN203 TH-type Male 7-pin FFC-7AMEP1 HTK
Connector

3 CN202, CN204, CN205 TH-type Male 2-pin FFC-2BMEP1 HTK
Connector

1 CN102 TH-type Male 14-pin FFC-14BMEP1 HTK
Connector

3 CN301-CN303 Connector 10-pin XB-3-7-10P Mac8

5 CN001-CN005 Banana Jack Yellow, Green, T-45 Sato Parts
Blue, Red, Black

1 CN101 USB Connector type B USB_TYPE-B 67068-8001 Molex

1 CN201 RCA Pin Jack Yellow LPR6520-0804 SMK

1 PJ402 RCA Pin Jack Red LPR6520-0802 SMK

1 PJ401 RCA Pin Jack White LPR6520-0803 SMK

2 SW102, SW201 DIP Switch DSS104 Fujisoku

2 SW202, SW302 Toggle Switch FT1D-2M Fujisoku

1 SW203 Toggle Switch FT1E-2M Fujisoku

3 SW101, SW204, SW301 Tact Switch Alps

2 TP401, TP402 Test Pin LC-2-G Mac8

1 TP201 Test Pin LC-4-G Mac8
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Bills of Material (BOMs) www.ti.com

Table 4-2. Bill of Materials: DEM-PCM1789
Qty Reference Designators Part Name, Type Specification Manufacturer Part No Manufacturer

3 C002, C004, C006 Chip Ceramic 1 µF GRM188B11A105(K) Murata
Capacitor

4 C001, C003, C005, C007 Electrolytic 10 µ/16 V R3A-16V100M ELNA
Capacitor

1 U001 IC DAC PCM1789 TI
1 HDR001 TH-type Male 3-pin FFC-3AMEP1 HTK

Connector
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EVALUATION BOARD/KIT IMPORTANT NOTICE
Texas Instruments (TI) provides the enclosed product(s) under the following conditions:
This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION PURPOSES
ONLY and is not considered by TI to be a finished end-product fit for general consumer use. Persons handling the product(s) must have
electronics training and observe good engineering practice standards. As such, the goods being provided are not intended to be complete
in terms of required design-, marketing-, and/or manufacturing-related protective considerations, including product safety and environmental
measures typically found in end products that incorporate such semiconductor components or circuit boards. This evaluation board/kit does
not fall within the scope of the European Union directives regarding electromagnetic compatibility, restricted substances (RoHS), recycling
(WEEE), FCC, CE or UL, and therefore may not meet the technical requirements of these directives or other related directives.
Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30 days from
the date of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY SELLER TO BUYER
AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE.
The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all claims
arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to take any and all
appropriate precautions with regard to electrostatic discharge.
EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.
TI currently deals with a variety of customers for products, and therefore our arrangement with the user is not exclusive.
TI assumes no liability for applications assistance, customer product design, software performance, or infringement of patents or
services described herein.
Please read the User’s Guide and, specifically, the Warnings and Restrictions notice in the User’s Guide prior to handling the product. This
notice contains important safety information about temperatures and voltages. For additional information on TI’s environmental and/or
safety programs, please contact the TI application engineer or visit www.ti.com/esh.
No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which such TI products or services might be or are used.

FCC Warning
This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION PURPOSES
ONLY and is not considered by TI to be a finished end-product fit for general consumer use. It generates, uses, and can radiate radio
frequency energy and has not been tested for compliance with the limits of computing devices pursuant to part 15 of FCC rules, which are
designed to provide reasonable protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense will be required to take whatever measures may
be required to correct this interference.

EVM WARNINGS AND RESTRICTIONS
It is important to operate this EVM within the input voltage range of –4 V to +4 V and the output voltage range of –4 V to +4 V.
Exceeding the specified input range may cause unexpected operation and/or irreversible damage to the EVM. If there are questions
concerning the input range, please contact a TI field representative prior to connecting the input power.
Applying loads outside of the specified output range may result in unintended operation and/or possible permanent damage to the EVM.
Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification,
please contact a TI field representative.
During normal operation, some circuit components may have case temperatures greater than +55°C. The EVM is designed to operate
properly with certain components above +55°C as long as the input and output ranges are maintained. These components include but are
not limited to linear regulators, switching transistors, pass transistors, and current sense resistors. These types of devices can be identified
using the EVM schematic located in the EVM User's Guide. When placing measurement probes near these devices during operation,
please be aware that these devices may be very warm to the touch.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2009, Texas Instruments Incorporated

http://www.ti.com/esh


IMPORTANT NOTICE
Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.
TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.
TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.
TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.
Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.
Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.
TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
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